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Einleitung

Installieren von Agilent 10 Libraries

~

Willkommen im Kreis der Agilent VEE-Nutzer!Agilent Visual Engineering
Environment (VEE) ist eine leistungsfahige visuelle Sprachumgebung, mit
der Sie Ihre Programme erheblich schneller entwickeln kénnen. Damit
Sie moglichst schnell mit Agilent VEE starten kénnen, wird in dieser
Anleitung gezeigt, wie die neue Software installiert und verwendet wird.
Auflerdem beinhaltet diese Anleitung zwei I"Jbungseinheiten, in denen
erlautert wird, wie tiber die USB-Schnittstelle auf ein Instrument zuge-
griffen und wie eine Wellenform von einer virtuellen Quelle generiert und
angezeigt werden kann.

Die Agilent IO Libraries Suite erhalten Sie beim Kauf von Agilent VEE.
Mit dieser Software konnen Sie liber serielle, USB-, GPIB- oder LAN-
Schnittstellen auf Instrumente zugreifen.

Die Agilent IO Libraries Suite 15.0 muss installiert sein, bevor Agilent VEE
installiert wird, wenn Sie tiber Agilent VEE auf ein Instrument zugreifen
miissen. Wenn Sie keine Instrumente verwenden, kénnen Sie sich jedoch
gegen die Installation der Agilent IO Libraries Suite entscheiden.

Fiihren Sie folgende einfache Installationsschritte aus:

1 Legen Sie die Agilent I0 Libraries Suite-CD in das CD-ROM-Laufwerk
ein. Klicken Sie im Fenster der Agilent IO Libraries Suite 15.0 auf Click
Here to Install Now, um mit der Installation zu beginnen.

I8 Agiant MO Libraries Seite 15.0

Agilent 10 Libraries
Suite 15.0

Click Here o
Install Now |

£ Agilent Technologios

/
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2 Der InstallShield® Wizard fiihrt Sie durch die Installationsvorginge.
Klicken Sie auf Next, um die Standardeinstellungen zu tibernehmen
und die Installation abzuschlief3en.

3 Das Fenster Agilent Connection Expert Welcome Screen wird ange-
zeigt. Mit dieser Anwendung werden die Instrumente konfiguriert, die
an den PC angeschlossen sind. Sie konnen dieses Fenster schlief3en,
bevor Sie den nichsten Schritt ausfiithren.

Welcome Screen

Verify and manage your Examine details

interfaces and instruments for the currently
selected device

Fie Edt Waw [J0 Configuration
([ RebsmhAl B lnds

Tasks for This Interface

[ &, YOURRC

L2 artveshtis 205 mtetce 7 com gashLLy i e ]
S come (asaLzy . ¥ -

A Chengn eopties o

] changsthelsbel

1] e NETRY
13’ Igrwoee =% umo
£ B (0029 L
2 ookl \ iy kmizel
|General Tasks
L nafrech A Task Guide

helps perform

B Add an struent
common DFIEI'BUU['IS
rare Information

o plel 2 Tep® (0 O 352rm

Shiow this window at startup 5
Quick Access to I/0 IO
tools & online help
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Installieren von Agilent VEE Pro oder Agilent VEE Express

1 Legen Sie die Agilent VEE-Installations-CD ein, und klicken Sie auf
Install Agilent VEE Pro 9.0 bzw. Install Agilent VEE Express 9.0. Der
InstallShield® Wizard fithrt Sie durch die Installationsvorginge.

Agilent VEE 9.0 Installation CD

Install Agilent VEE Pro 9.0

Install Agilent VEE Express 9.0

Install Agilent VEE Runtime 9.0
Install Microsoft .NET Framework 3.5

Informationen zu den Produktunterschieden finden Sie auf Seite 19.

2 Der InstallShield® Wizard priift nun, ob Agilent IO Libraries Suite 15.0
installiert ist. Ist dies nicht der Fall, wird das folgende Meldungs-
fenster angezeigt.

Agilent VEE Pro - InstallShield Wizard

E Agilent IO Libraries Suite 15.0 or greater is not found,

o Agilent VEE requires Agilent IO Libraries Suite 15,0 or greater for communicating with instruments,
Please install Agilent I Libraries Suite 15.0 or greater after finishing this setup,

Beachten Sie, dass Agilent IO Libraries Suite 15.0 eine Voraussetzung fiir
den Zugriff auf Instrumente tiber Agilent VEE ist. Darum installieren Sie
bitte nach Abschluss dieser Installation Agilent IO Libraries Suite 15.0
oder hoher.

Klicken Sie auf OK.Der InstallShield® Wizard priift nun, ob Microsoft NET
Framework 3.5 installiert ist.
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3 Falls Microsoft NET Framework 3.5 nicht installiert ist, werden Sie in
einem Dialogfenster gefragt, ob Sie es installieren mochten. Klicken Sie
auf Yes, um Microsoft .NET Framework 3.5 sofort zu installieren. Nach
der Installation wird die Agilent VEE-Installation automatisch fortge-
setzt. Wenn Sie auf No klicken, wird die Agilent VEE-Installation abge-
brochen.

Wenn Microsoft .NET Framework 3.5 installiert ist, flihrt der
InstallShield® Wizard Sie direkt zum nichsten Schritt, der Installation
Ihrer Agilent VEE-Auswahl in Schritt 1.

Question

® ) Microsoft \NET Framework 3.5 must be installed before installing Agilent YEE,
\\/ Do you want to install Microsoft \MET Framework 3.5 now?

‘es ] [ Mo

4 Klicken Sie auf Next, wenn das folgende Dialogfenster angezeigt wird.

Agilent VEE Pro 9.0 Setup X

Welcome to the InstallShield Wizard for Agilent
YEE Pro

The InzstallShield® wizard will install Agilent VEE Fro on
your computer. To continue, click Mest.

Mext > ][ Cancel

b Akzeptieren Sie den Lizenzvertrag, wenn das License Agreement-
\ Dialogfenster angezeigt wird, und klicken Sie auf Next.
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Agilent VEE Pro 9.0 Setup

License Agreement =
Fleaze read the following license agreement carefully. %

The license agreements contained here are for 2 different uses of this ~
product. Please review and click to accept the appropriate license
agreement for the product you are installing, either a purchased product,

or a 30-day Evaluation usage.

Ewvaluation License

LEGAL MOTICE: PLEASE READ THESE LICENSE TERMS BEFORE
INSTALLING OR OTHERWISE USING THE LICENSED MATERIALS.
ALL USE OF THESE LICENSED MATERIALS 1S SUBJECT TO THE v

(®) | accept the terms of the license agreement

(| da not accept the terms of the license agreement

< Back " Mext > ][ Cancel ]

6 Geben Sie Ihren Namen, Unternehmensnamen und Produktschliissel
ein, wenn das Customer Information-Dialogfenster angezeigt wird, und
klicken Sie auf Next. Den Produktschliissel finden Sie im Agilent VEE
Pro oder Agilent VEE Express Product Key Certificate.

Agilent VEE Pro 9.0 Setup X

Customer Information
Fleaze enter your information.
User Mame:

bilab-uzers

Company Mame:

agilent lab

Product Key [Enter EVAL for a 30-day evaluation install):
Evial
Install thiz application for:

(®) Anyone wha uzes this computer [all users)

) Only for me (bilab-users)

[ < Back " Mext > ][ Cancel

/
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7 Klicken Sie auf Next, um die Standardeinstellungen zu akzeptieren,
wenn das folgende Dialogfenster angezeigt wird.

Agilent VEE Pro 9.0 Setup
Choose Destination Location -
Select folder where setup will install files, 2\/

Setup will install Agilent YEE Pra in the following folder.

Ta install to this folder, click Mext. To install to a different folder, click Browse and select
another folder.

Destination Folder

C:\Program FilesAgilent'VEE Fro 9.0

< Back " Mext > ][ Cancel ]

8 Wihlen Sie Typical Setup, wenn das Setup Type-Dialogfenster angezeigt
wird, und klicken Sie auf Next, um die Installation abzuschlieRen.

Agilent VEE Pro 9.0 Setup

Setup Type -
Select the zetup type to install 2\/

Click the type of setup vou prefer, then click Mext.

() Typical Program will be installed with the most common options. Recommended for
most uzers.

(O Compact  Pragram will be installed with minimum required aptions.

() Custom “r'ou may zelect the options you want to ingtall. Recommended for advanced
LsErs.

< Back " Mext > ][ Cancel

\_ J
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Starten von Agilent VEE Pro oder Agilent VEE Express

Meniileiste
Fle Edt Wew Debug Flow Device System IfO0 Data Display Tooks Datsbase Excel Window  Help
NEEHD 6 a@9yir oo Dbt AR EELBEF, s Taw @EZRE
Symbolleiste s B Ve
5 Untitled =
s RER 2
g
g
Program 3
o)
2
Explorer v g
/ ™
2
H
. . g
Arbeitsbereich | 2
b
o
BegriiBungs- e
_g g Froperties > Agllent VEE Pro +i3 Agilent Technologies &
seite Wain [Main)] - M - e~ :
ntroduction f
24l _Introduetioh __ Tip of the Day
B Appearance RIS LT You can view 3 VEE Ohiect's menu by clicking
. on the upper-left hand comer of the abject or
E|genschaﬂen- — 1 g_’,io, WebiDsmos by right-clicking anywhere over the object.
Convert Infinity t False MATLAB Examples
ieHSter B Design Example Programs
E Popup Panel ] ]
[¥ Shows this screen at startup
Ausgabefenster
Title
( 0 Utpl") Title sting of the obiset
Statusleiste =l
dy Exechlode: VEES

~

Wechseln Sie zu All Programs (Alle Programme) > Agilent VEE Pro 9.0 > VEE Pro
9.0 bzw. All Programs (Alle Programme) > Agilent VEE Express 9.0 > VEE Express
9.0, um Agilent VEE Pro bzw. Agilent VEE Express zu starten.

Uber die BegriiRungsseite von Agilent VEE Pro oder Agilent VEE Express
konnen Sie auf die Demos, die MATLAB-Beispiele (nur in Agilent VEE
Pro verfiigbar) sowie Beispielprogramme zugreifen. Nachdem Sie sich die
BegriiRungsseite angesehen haben, konnen Sie diese schlieRen.

Beispielprogramme konnen Sie auch iiber die Meniileiste 6ffnen. Wenn
Sie ein Beispielprogramm 6ffnen mochten, wéihlen Sie File > Open Example
... oder Help > Open Example ... aus.
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Zugreifen auf ein Instrument - Ubungseinheit

In dieser ["Jbungseinheit wird tber die USB-Schnittstelle eine Verbindung
zu einem Instrument hergestellt. Fithren Sie die weiteren Schritte erst
aus, nachdem Sie sich vergewissert haben, dass die Agilent 10 Libraries
Suite 15.0 installiert ist.

Wenn Sie kein USB-Instrument haben, konnen Sie zu Schritt 3 springen.
Die Ubungseinheit ist ab diesem Schritt fiir ein GPIB-Instrument gleich.

Die folgenden Screenshots wurden Agilent VEE Pro erstellt. Screenshots
fiir Agilent VEE Express sehen dhnlich aus.

1 Stellen Sie iber einen USB-Anschluss des PCs eine Verbindung zum
Instrument her. Schalten Sie dann das Instrument ein. Méglicherweise
wird der Assistent fiir das Suchen neuer Hardware (Found New
Hardware Wizard) angezeigt. Folgen Sie dem Assistenten, indem Sie
auf Next klicken.

2 Wenn das Dialogfenster ,Assign USB device alias“ angezeigt wird, miis-
sen Sie auf OK klicken, um die Schnittstelle im System zu registrieren.

Assign USB device alias @I

Alias name: | UsbDevice2

Identification: | Agilent Technologies 344104 Digital Multimeter

Wisa Resource Mame:

Preferred | UsbDevice2

Alternate | USED: 239115435 MY45001050:: 00 INSTR,

SICL Address String:

Preferred | UsbDevice2

Alternate | usb0[2391::1543::MY45001050::0]

Show this dialog
% Each time a USE device is plugged in.
" wWhen a new USE device is plugged in.

Ok | Cancel /

" Mever show this dialog

Agilent VEE Pro 9.0 und Agilent VEE Express 9.0 — Kurzanleitung 9
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3 Starten Sie Agilent VEE Pro oder Agilent VEE Express, sofern Sie d@
nicht bereits getan haben. Klicken Sie in der Symbolleiste auf das Sym-

bol Instrument Manager __
HEH

4 Das Toolfenster Instrument Manager wird angezeigt. Klicken Sie auf
die Schaltflache Find Instruments@ , um automatisch alle Instru-
mente zu ermitteln,

By S H& in ke

| [Find Instruments (Ctri+F)]

die mit Threm PC verbunden sind. Klicken Sie auf Yes, wenn das

Popup-Dialogfenster ,Identify Instrument” angezeigt wird. Dadurch
wird das Instrument an der USB-Schnittstelle automatisch erkannt
(identifiziert). In diesem Beispiel ist ein digitales Agilent 34410A Multi-
meter vorhanden.

Identify Instrument
Send "*IDMN?" to newlnstrument  { @USB0:2391:1543:MY45001050:0:INSTR)'?

The response to "*IDN?" provides an
@ accurate identification of this instrurment.

Mote: Older, non 488.2 campliant instruments do not

understand this command. Ifthis command causes an
errar in the instrument, cycle the power on the

instrument to reset it.
il Mo

5 Klicken Sie mit der rechten Maustaste im Bereich ,Instrument List®
auf den Eintrag fiir das neue Instrument (newInstrument). Wahlen Sie
anschlieend Create Direct 1/0 Object im ge6ffneten Kontextmenii, um
das Direct I/O-Objekt fiir das ausgewahlte neue Instrument
(newinstrument) auf dem Arbeitsbereich zu platzieren. Uber dieses
Objekt konnen Sie Befehle an das/vom Instrument senden/empfangen.

/
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newlnstrument{ag3441 Da@L bl

§  Create Direct IfO Object

E Add Instruments ...

Configure Drivers

Load Sample

@ Remave DEL
=)

Properties...

6 Doppelklicken Sie auf die blaue Transaktionsleiste des Direct
I/0-Objekts, damit Sie ihm eine Transaktion hinzufiigen konnen.

7 Geben Sie im Dialogfenster I/0 Transaction die Zeichenfolge "*IDN?"
ein. Geben Sie auch die Anfithrungszeichen ein (siehe Abbildung). Wah-
rend der Eingabe wird moglicherweise eine Liste verfigbarer SCPI-
Befehle angezeigt. Sie konnen den gewiinschten Befehl wahlen, anstatt
den ganzen Befehl einzugeben. Klicken Sie zum Fortsetzen auf OK.

*IDN? ist einer der Standardbefehle fiir programmierbare Instrumente
(SCPI - Standard Commands for Programmable Instruments). Dieser Befehl
fragt die Identifikationsszeichenfolge eines Instruments ab.

— | newinstrument (ag34410a @UsbDevice2) |
= Double-Click to Add Transaction = v

/0 Transaction

:
| wrRITE ~| | TEXT =] [P*DN?

[ DEFAULTFORMAT  ~¥| EOLON

ok | mnop | cancel|

8 Nach dem Senden der Abfrage "*IDN?" an das Instrument muss dessen
Antwort gelesen werden. Doppelklicken Sie auf das Textfeld des newlIn-
strument-Objekts, damit Sie eine neue Transaktion hinzufiigen kénnen.
Wiahlen Sie jezt die Transaktion READ zur Ausgabe eines Textes im STRING
FORMAT (Zeichenfolgenformat) an einem Ausgabeterminal x. Der Aus-

\ gang x wird automatisch erstellt, sobald Sie auf 0K geklickt haben. /
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WRITE TEXT "*IDMN?" EOL

= Double-Click to Add Transaction =
YO Transaction

| READ ~| | TEXT x| K
DEFAULT NUM CHARS

ok | mnop | cancel|

9 Wibhlen Sie Display AlphaNumeric aus und ordnen Sie ein AlphaNume-
ric-Objekt im Arbeitsbereich rechts neben dem Direct I/O-Objekt an.

Display | Tools Database E;
|[:J Alphaklurmeric h

r‘\‘}
[=2 Logging AlphaMumeric

Indicator »

10 Das Direct I/O -Objekt soll nun mit dem AlphaNumeric-Objekt verbun-
den werden. Platzieren Sie den Cursor neben dem Ausgang des Direct
I/0-Objekts. Es wird ein quadratisches Symbol angezeigt. Klicken Sie
mit der linken Maustaste und ziehen Sie eine Linie zum Eingabean-
schluss (input terminal, Eingang) des AlphaNumeric-Objekts. Klicken
Sie erneut mit der linken Maustaste, um die Verbindung abzuschlief3en,

—|newinstrument (ag34410a @UshDevice2) | «|

WRITE TEXT "*IDN?" EOL |— AlphaMumeric| «
READ TEXT x 8TR -
= Double-Click to Add Transaction = | —

11 Fihren Sie das Programm aus, indem Sie in der Symbolleiste auf das
Symbol Run p- | Klicken. /
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12 Das AlphaNumeric-Objekt zeigt die Identifikationszeichenfolge an, die
das Instrument ausgegeben hat (siehe folgende Abbildung).

—|newinstrument (ag34410a @UshDevice2) | «|

WRITE TEXT "IDN?" EOL —| AlphaNumeric =

READ TEXT % STR _ ¥ I— 1 Agilent Technologies, 344104 MY45001050,2.03-2.03-0.03-43-6
= Double-Click to Add Transaction =

13 Zum Speichern des VEE-Codes wéhlen Sie File > Save As aus. Geben Sie
der Datei den Namen Uebungseinheit 1.vee.

. J
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Virtuelle Quelle (Virtual Source) - Ubungseinheit

In dieser ﬁbungseinhei‘c generieren Sie eine Wellenform aus einer virtuel-
len Quelle und zeigen diese Wellenform an. Es ist kein Instrument erfor-

derlich.

1 Wenn im Arbeitsbereich von Agilent VEE Pro oder Agilent VEE
Express ein Programm vorhanden ist, wéihlen Sie File > New aus.
Wihlen Sie dann Device > Virtual Source Function Generator aus, und
ordnen Sie im Arbeitsbereich ein Function Generator-Objekt an.

Device | System  L/0  Data Display Tools Database Excel  Wind

= Formula S 0B RR @
4\ MATLAB Script
F& Function & Object Browser Chrl+H !
[“y UserObject
[#] ThreadObiject
% UserFunction
Call
Ll Import Libraty
sl Delete Library
Sequencer
| Wirtual Source L4 | Function Generatar
Regression Pulse Generator
-|—+I| Counter Moise Generator

2 Der Funktionsgenerator erzeugt standardméifig eine virtuelle
Cosine-Wellenform (Kosinus) mit der Frequenz (Frequency) 200 Hz
und der Amplitude 1.

—| Function Generator =]

Function | Cosine =]
Frequency 200

Amplitude [ 1
DcOffset ’f Func 1
Phase [Deg =] 0

Time Span 20m

Mum Points 255

~

/
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3 Waihlen Sie Display > XY Trace aus, und legen Sie ein XY Trace-Objekt
rechts neben dem Function Generator-Objekt ab.

Display | Tools Database E:

) Alphahumeric

[=5  Logging AlphaMumeric
Indicator 4

{wy  BY Trace

e Strip Chart

Complex Plane

4 Verbinden Sie den Ausgang des Function Generator-Objekts mit dem
Eingang des XY Trace-Objekts. Platzieren Sie den Mauscursor neben
dem Ausgang des Function Generator-Objekts. Es wird ein quadrati-
sches Symbol angezeigt. Klicken Sie mit der linken Maustaste und zie-
hen Sie eine Linie zum Eingang des XY Trace-Objekts. Klicken Sie
erneut mit der linken Maustaste, um die Verbindung abzuschlief3en.

= XY Trace =

= Function Generator = Y name

Function | Cosine =]

Freguency 200

Amplitude [ 1

DcOffset 0 Func —81

Phase Deg =] o [Tzt
Time Span 20m
Mum Points 255 0

4 [

X name

5 Klicken Sie in der Symbolleiste auf das Symbol Run ™ | . Danach wird
die Kosinuswellenform im XY Trace-Objekt angezeigt.

. J
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6 Waihlen Sie Display > Spectrum (Freq) Magnitude Spectrum aus und legen
Sie im Arbeitsbereich ein Magnitude Spectrum-Objekt unter dem XY
Trace-Objekt ab.

Device  System  LI/O  Data | Display | Tools Database Excel Window Help

| D‘g)x(ﬁ= Boou |1 Alphatiumeric ='<Q§’33& j@ﬁr ﬁ.gj

I = Looano Aphetumere

Indicator

{w¢ mY Trace

iy atrip Chart
Complex Plane

faly Hws Y Plot

{Z Polar Plot

v waveform (Time)

| Spectrum (Fredq)

¥ Trace =

Lo Magnitude Spectrum

-

— Function Genera Ficture Phase Spectrum

Function Cosine Label Magnitude vs Phase (Polar)
Freguency 20 Beep Magnitude ws Phase {Smith)
Amplitude 1 Mote Pad

Droffset 0 Func —

Phase m [0 UEES, 0:2
Time Span 20m 100m
Murm Points 755 o
= 0 02 04 06 08 1

Hname

71 Ziehen Sie geméiR der in Schritt 4 beschriebenen Methode des Links-
klickens und Ablegens eine zweite Linie vom Ausgang des Function
Generator-Objekts zum Eingang des Magnitude Spectrum-Objekts.

8 Klicken Sie auf das Symbol Runﬂ , und sehen Sie sich die Anzeige
des Magnitude Spectrum-Objekts an. Da die Wellenform einer 200-Hz-
Kosinuswelle entspricht, zeigt das Magnitude Spectrum-Objekt eine
vertikale Linie bei der Frequenz 200 Hz an.

- /
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=l XY Irace =
1 -

= 0.8
= Function Generator = Yname
Function Cosine - 7l
Frequency 200 02
Amplitude 1 x
0.2
DcOffset 0] Func — i
Phase Deg = 0 Tracel @@
Time Span 20m s

Num Points e - " ) K /

256 dJ bl
= 0 4m  8m  12m  16m 20m
X name
= Magnitude Spectrum =
140 -
Mag 120
100
80
60
1
Tracet *°
20
T Iy
0 2000 4000 60007000
Freq
Andern Sie die Funktion im Generator fiir virtuelle Funktionen in eine

rechteckige (Square) Wellenform.

Function Generator =

Function

Sine
Frequency X
q : Cosine

Amplitude Square

DcOffset Fune |
+Ramp

Phase -Ramp

Time Span | 22001

Mum Points 255
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10 Klicken Sie auf das Symbol Run > und beobachten Sie den Unter-
schied. Agilent VEE bietet Ihnen die Moglichkeit, eine Signalquelle
gleichzeitig in mehreren Grafikdarstellungen zu analysieren.

= XY Trace =
1
- 0.8
= Function Generator &= | rreme
Function Square > 0.4
Frequency 200 0.2
Amplitude 1 0
-0.2
DcOffset 0 Func [i—1 o
Phase Deg = 0 Tracet e
Time Span 20m 0.8
Mum Points 25 -1
256 4 [v]
= 0 4m  8m  12m  16m 20m
X name
= Magnitude Spectrum =
180
Mag 180
140
120
100
a0
— 60
Trace1

[

o 2000 4000 60007000

Freq

11 Zum Speichern des VEE-Codes wéhlen Sie File > Save As aus. Geben Sie
der Datei den Namen Uebungseinheit 2.vee.

)
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Unterschiede zwischen Agilent VEE Pro und Agilent VEE
Express

In der folgenden Tabelle sind die Unterschiede zusammengestellt, die es
zwischen Agilent VEE Pro und Agilent VEE Express gibt.

Funktionen Agilent VEE Pro Agilent VEE

Express

Schnittstellen GPIB, LAN, RS-232, v x
VXI, PXI, SCXI

USB v

v (Agilent

USB-Geréate nur in
LiveMode)
MatlabScript-Objekte und Matlab- v x
Script-Modul

Erstellen von Laufzeitversionen von Agi- v x

lent VEE-Programmen und geschiitzten
secured) Versionen von Agilent
VEE-Objekten

Programmgesteuertes Andern von Instru- v x
mentenadressen

Funktion Callable Server (,Aufrufbarer Ser- v x
ver“), d. h., Agilent VEE kann als ActiveX-

IAutomatisierungsserver aufgerufen werden

Verwenden von fernen Funktionen, d. h., es W, x
konnen Benutzerfunktionen importiert

werden, die in einem anderen Agilent VEE-
Prozess auf einem fernen Hostcomputer
ausgefiihrt werden

Weitere Funktionen v v

Agilent bietet auch die Versionen Agilent VEE Student und Agilent
\ Education fiir Benutzer im Ausbildungsbereich an.

Agilent VEE Pro 9.0 und Agilent VEE Express 9.0 — Kurzanleitung 19
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Agilent VEE 9.0 — neue Eigenschaften

~

Multithreading -Diese Funktion kann die Leistung Ihres mit Agilent VEE
erstellten Systems steigern. Mit dieser Funktion konnen Sie miihelos
mehrere Threads in einem Agilent VEE-Programm erstellen, um kiirzere
Ausfiihrungszeit, hohere Reaktionsgeschwindigkeit sowie hoheren
E/A-Durchsatz zu erzielen. Mit der Multithreading-Funktion wird aufier-
dem ein neuer Ausfithrungsmodus eingefiihrt.

Multicore-Programmierung - Mit dieser Funktion erhalten Sie die Fahig-
keit zur Multicore-Programmierung. Sie kénnen die Leistung Threr Multi-
thread-Programme sogar noch weiter steigern, indem Sie bestimmten
CPU-Kernen verschiedene Threads zuweisen, falls Ihr Computer tiber
eine Multi-Core-CPU verfugt.

SCPI-Vervollstindigung - Mit dieser Funktion konnen Sie miihelos einen
SCPI-Befehl aus einer Liste auswihlen, die wihrend der Eingabe eines
SCPI-Befehls im IO Transaction Object angezeigt wird. Eine Beschreibung
des ausgewihlten SCPI-Befehls wird ebenfalls angezeigt. Der Zeitaufwand
zur Suche in SCPI-Handbiichern und Uberpriifung von Syntaxfehlern
wird so deutlich reduziert. Dariiber hinaus konnen Sie sogar Ihre eigene
SCPI-Befehlsdatei wahlen, anstatt die automatisch von VEE ausgewihlte
standardméaRige SCPI-Befehlsdatei zu verwenden.

Private UserFunction - Agilent VEE 9.0 bietet einen neuen Typ von
UserFunction: Private UserFunction hilft Ihnen, Ihre VEE-Programme
besser zu modularisieren und fiir umfangreichere Anwendungen zu ver-
kapseln.

Conditional Breakpoint - Mit Conditional Breakpoint sind Sie in der
Lage, Bedingungen und Zahler fir einen Haltepunkt festzulegen and
anzugeben, was beim Erreichen eines Haltepunkts geschehen soll. So
haben Sie grof3ere Kontrolle tiber den Debuggingprozess und erzielen eine
hohere Effizienz.

Breakpoints-Fenster - Im Breakpoints-Fenster konnen Sie alle Halte-
punkte in Threm VEE-Programm beobachten und kontrollieren. Sie kon-
nen Haltepunkte z. B. aktivieren oder deaktivieren als auch 16schen.

Error Call Stack - Nutzen Sie den Error Call Stack als Hilfe zum Debuggen
Ihres VEE-Programms. Im Error Call Stack werden das UserObject bzw. die
UserFunction angezeigt, wo der Fehler auftritt. AuRerdem zeigt der Erroy
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( Call Stack auch in einer Liste oder Hierarchie an, welches UserObject \
oder welche UserFunction das derzeit ausgefiihrte Objekt aufruft, in dem
der Fehler auftritt.

Integrierte Datenbankunterstiitzung — Mit dieser Funktion konnen Sie
miihelos zu jeder von ADO.NET unterstiitzten Datenbank eine Verbin-
dung herstellen, z. B. Microsoft Access, Microsoft SQL Server, Oracle,
MySQL etc. Sie konnen in dieser Datenbank grof3e Testdatenmengen in
gut strukturiertem Format speichern und dann bei Bedarf jederzeit zu
Analyse- oder Testzwecken abrufen.

LXI-Unterstiitzung - Alle LXI-Instrumente verfiigen iiber eine
Web-Schnittstelle, die niitzliche Informationen tiber das Instrument bie-
tet, eine Standardmoglichkeit zur Konfiguration der LAN-Schnittstelle
sowie weitere Funktionen. Agilent VEE bietet eine komfortable Moglich-
keit zum Offnen einer LXI-Web-Schnittstelle eines Instruments in einem
VEE-integrierten Web Browser.

Verbesserter Default Preferences-Dialog - Das Default Preferences-Dia-
logfenster wurde umgestaltet und verbessert, damit Sie nicht nur in den
Genuss einer modernen Programmiererfahrung, sondern auch ver-
besserter Funktionalitit kommen.

Erweiterte Unterstiitzung fiir benutzerdefinierte Meniis - Neben dem
Textformat unterstiitzt Agilent VEE 9.0 auch das XML-Format. AuRerdem
finden Sie in Agilent VEE 9.0 auch zwei Tools fiir benutzerdefinierte
Meniis, mit denen Sie benutzerdefinierte Meniis bearbeiten und vom alten
Textformat in das neue XML-Format konvertieren konnen.

Neue Symbolleisten fiir VEE-Objekt - Einigen hiufig verwendeten
VEE-Objekten werden ein neuer Satz von Symbolen sowie einige neue
Symbolleisten zugeordnet. Sie konnen ein VEE-Objekt leichter in diesen
Symbolleisten als im Hauptmenii auswéahlen.

Unterstiitzung fiir NaN und Infinity — Agilent VEE 9.0 unterstiitzt NaN
und +/-Infinity fiir die Datentypen Real64 sowie Real32 und bietet vier
integrierte Funktionen: isNaN, isInfinity, isNegativeInfinity, isPositiveInfi-
nity. VEE beherrscht die NaN-/Infinity-Konvertierung von Zahlen in Zei-
chenfolgen und umgekehrt und ermdéglicht NaN und Infinity in .NET und
MATLAB die Ausgabe an VEE und umgekehrt.

Neue Beispiele - Neue Agilent VEE-Beispiele fir einige hiufig verwen-
dete VEE-Objekte verhelfen Ihnen zu einem schnellen, miithelosen Ler-

\ neinstieg.
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4 Agilent-Konnektivitatsprodukte )
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Agilent bietet eine umfassende Palette von sehr leistungsfihigen und
zuverldssigen Produkten an, tiber die PCs mit Instrumenten verbunden
werden konnen. Dazu gehoren ein netzwerkbasierter USB-Hub, ein
LAN/GPIB-Gateway sowie PCI/GPIB-, USB/GPIB- und USB/RS232-
Schnittstellen. Weitere Informationen zu den Konnektivititsprodukten
von Agilent finden Sie hier: www.agilent.com/find/io.

Agilent-Unterstiitzung, -Dienstleistungen und
-Aktualisierung

Mit Agilent VEE Pro und Agilent VEE Express haben Sie Zugriff auf die
weltweiten Agilent-Ressourcen fiir die Erstunterstiitzung, fiir Schulungen
und fiir Aktualisierungen. Mit dem Kauf irgendeines Agilent VEE-Pro-
dukts erwerben Sie das Recht, kostenfreie technische Unterstiitzung zu
erhalten. Eine Registrierung ist nicht erforderlich.

Agilent bietet weitere Beratungsdienstleistungen an. In den USA, in Eur-
opa und im Nahen Osten gibt es momentan mehr als 30 Unternehmen,
von denen Sie beim Entwickeln von Agilent VEE-Losungen unterstitzt
werden kénnen.

Melden Sie sich fiir die elektronische Agilent VEE-Benutzergruppe unter
http://www.agilent.com/find/vrf an. Hier erhalten Sie von Experten auf
\ der ganzen Welt Hilfe zum Arbeiten mit Agilent VEE. /
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Anhang

\_

Agilent VEE Pro Help steht jetzt auch in anderen Sprachen zur Verfiigung.
Um Online-Hilfedateien in anderen Sprachen zu nutzen, fithren Sie bitte
folgende Schritte aus:

1

Laden Sie die lokalisierte Online-Hilfe unter
www.Agilent.com/find/vee herunter.

Speichern Sie heruntergeladene Dateien im Installationsverzeichnis
von Agilent VEE. In der Regel ist dies C:\Programme\Agilent\VEE Pro 9.0.
Andern Sie die Namen der heruntergeladenen Online-Hilfedateien
bitte nicht.

3 Offnen Sie Agilent VEE.

4 Offnen Sie ,Default Preferences“ (File => Default Preferences). Wihlen

Sie die gewiinschte Hilfedateisprache auf der Registerkarte ,Help“.

Klicken Sie auf ,0K“, um das Dialogfenster ,Default Preferences“ zu
schlief3en.

Microsoft ist eine in den USA eingetragene Marke der Microsoft Corporation.

J
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www.agilent.com

Kontaktdaten

Um unsere Services, Garantieleistungen oder
technische Unterstiitzung in Anspruch zu neh-
men, rufen Sie uns unter einer der folgenden
Telefonnummern an:

Vereinigte Staaten:

(Tel) 800 829 4444 (Fax) 800 829 4433
Kanada:

(Tel) 877 894 4414 (Fax) 800 746 4866
China:

(Tel) 800 810 0189 (Fax) 800 820 2816
Europa:

(Tel) 31 20 547 2111

Japan:

(Tel) (81) 426 56 7832  (Fax) (81) 426 56 7840
Korea:

(Tel) (080) 769 0800 (Fax) (080) 769 0900
Lateinamerika:

(Tel) (305) 269 7500

Taiwan:

(Tel) 0800 047 866 (Fax) 0800 286 331
Andere Lander im Asien-Pazifik-Raum:

(Tel) (65) 63758100 (Fax) (65) 6755 0042

Oder besuchen Sie uns im Internet:
www.agilent.com/find/assist

Anderungen der Produktspezifikationen und

-beschreibungen in diesem Dokument vorbe-
halten.

[0 Agilent Technologies, Inc. 2008

Gedruckt in Malaysia
30. August 2008

W4000-90030

Agilent Technologies



	Agilent VEE Pro 9.0 und Agilent VEE Express 9.0
	Inhalt
	Einleitung
	Installieren von Agilent IO Libraries
	Installieren von Agilent VEE Pro oder Agilent VEE Express
	Starten von Agilent VEE Pro oder Agilent VEE Express
	Zugreifen auf ein Instrument - Übungseinheit
	Virtuelle Quelle (Virtual Source) - Übungseinheit
	Unterschiede zwischen Agilent VEE Pro und Agilent VEE Express
	Agilent VEE 9.0 - neue Eigenschaften
	Agilent-Konnektivitätsprodukte
	Agilent-Unterstützung, -Dienstleistungen und -Aktualisierung
	Anhang



